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1 Introduction

The Research and User Support for Sentinel core products (RUS) service provides a free and open
scalable platform in a powerful computing environment, hosting a suite of open source toolboxes pre-
installed on virtual machines, to handle and process data acquired by the Copernicus Sentinel satellites
constellation.

Earthquakes occur very often worldwide, especially in volcanic regions like Hawaii. They can be caused
by tectonic faults, by the movement of magma in volcanoes (volcano tectonic earthquakes) and be
related to dike intrusion.

The earthquake occurred in the south-
east of the Hawaii archipelago on May
4, 2018 at the Hawaii Island, was of
magnitude of Mw 6.9 and produced
around 5 meters of fault slip. It is the
largest earthquake affecting this
region after the one in 1975, where 2
people were killed and another 28
were injured.

\ This event was related to the new lava
#%—Jﬁ‘w . outbreaks at the Kilauea Volcano and

the aftershock events continued until
August 2018. The earthquake
produced a minor tsunami that

All earthquakes recorded at the area of study from 15 March 2018 to reached a maximum height of 40 cm in
15 August 2018 with magnitude 3.5 - 7.0. In blue, the event of 4 May Kapoho, 20 ¢cm in Hilo and 15 cm in
2018. (Source: https://earthquake.usgs.qov/earthquakes/map/)

Honuapo.

Hawaii region is known as one of around 60 hotspots that exist in the world and its islands are formed
due to the continuous flow of magma towards the surface. The tectonic plate is moving to a north-
west direction while the hotspot remains at the same location, creating new volcanoes. This is the
reason why the youngest island is located to the south-east and why only the volcanoes in the
southern half are active. Seismic activity will always take place in such regions and sometimes it can
also be related to volcanic eruptions.

2 Training
Approximate duration of this training session is two hours.

The Training Code for this tutorial is HAZAO05. If you wish to practice the exercise described below
within the RUS Virtual Environment, register on the RUS portal and open a User Service request from
Your RUS service = Your dashboard.

2.1 Data used

*  Two Sentinel-1A IW SLC images with VH & VV polarization acquired on 23 April 2018 and 5 May
2018 [downloadable at https://scihub.copernicus.eu/]

S1B_IW_SLC__1SDV_20180423T161524_20180423T161551_010613_0135DD_33F0
S1B_IW_SLC__1SDV_20180505T161525_20180505T161552_010788_013B7D_25D2


https://rus-copernicus.eu/
https://scihub.copernicus.eu/
https://earthquake.usgs.gov/earthquakes/map/

2.2  Software in RUS environment

Internet browser, SNAP + Sentinel-1 Toolbox, QGIS, (Extra steps: Google Earth)

3 Register to RUS Copernicus

To repeat the exercise using a RUS Copernicus Virtual Machine (VM), you will first have to register as
a RUS user. For that, go to the RUS Copernicus website (www.rus-copernicus.eu) and click on

Login/Register in the upper right corner.

Login / Register &

v News from RUS

One year on!
Copernicus Info Session - Reykjavik - 19 September 2018

SPIE Remote Sensing 2018 - Berlin (Germany) - 11-12
September 2018

SIWI World Water Week 2018 - Stockholm - 26-31
August 2018

MedRIN Kick-off Meeting - Chania - 13 & 14 July 2018

00000 0000 RUS Webinar - Special edition “AskRUS - Sentinel-1” - 12

July 2018

v Welcome to Research and User Support RUS Training Session - Valencia - 22 July 2018

IGARSS 2018 - Valencia - 22-27 July 2018

Welcome to the Copernicus Research and User Support (RUS) Service portal!

v The RUS agenda

The RUS Service is the “New Expert Service for Sentinel Users” funded by the European Commission,

fimanaeed hv/the Friranean Snace Asency and onerated bv CS Sl and its nartner

Conferences & Workshops

Select the option Create my Copernicus SSO account and then fill in ALL the fields on the Copernicus
Users’ Single Sign On Registration. Click Register.

Login / Register

Registered RUS users, as well as persons who already own
a Copernicus SSO account, can directly access our service.

Newcomers shall first create an account on the Copernicus Single Sign-On (S50)
authentication server used to support registration to the RUS service. [

st name
Last name
Create my Copernicus SSO account n

NB: persons using a Google e-mail address for registration shall check
their mailbox spam folder regularly as Google tends to fifter RUS e-mails.

Close

Within a few minutes you will receive an e-mail with activation link. Follow the instructions in the e-

oo eOoOOROQOOR®

mail to activate your account.

You can now return to https://rus-copernicus.eu/, click on Login/Register, choose Login and enter

your chosen credentials.


http://www.rus-copernicus.eu/
https://rus-copernicus.eu/

Login / Register Credentials

The registration system to access the RUS service platform has moved toward the

COPERNICUS Single Sign On authentication server CDS-550 ID (7]
* New Users who have not yet registered to the RUS portal shall first create a
COPERNICUS S50 account. Password 0
Note that your Copernicus SSO account will be activated only after the reception of
the third email sent by the Copernicus service. We advise you to consult this document
and this page to facilitate your registration procedure. Max Idle Time half a day v 0
REGISTER COPERNICUS Max Session Time | Until browser close AL 7 ]
S50 account
Users who already have a COPERNICUS S5O account can login here: Login Reset

Forgot your password?

Upon your first login you will need to enter some details. You must fill all the fields.

Do you want to subscribe for a new RUS account?

SO subscription data:

Additional subscription information

Please complete the following information

tthe outreach event
colleagues
newsletter
conference
soclal media
other
- Sefect one item

39

— Select one item -

[ sroe | come |

4 Request a RUS Copernicus Virtual Machine

Once you are registered as a RUS user, you can request a RUS Virtual Machine to repeat this exercise
or work on your own projects using Copernicus data. For that, log in and click on Your RUS Service =
Your Dashboard.

(e UsersuPport - Hello, Miguel &

@ The RUS Service ¥ The RUS Offer ¥ The RUS Library ¥ The RUS Community ¥ -

€A Your profile

You are here: Home > Your RUS service

&1 Yourtraining
This section gathers pages related to your RUS services:

ews from R
= Your profile: displays your personal information linked to your ESA SSO and RUS accounts,

One year on!

llows you to access your private dashboard, Copernicus Info Session - Reykjavik - 19 September 2018

SPIE Remote Sensing 2018 - Berlin (Germany) - 11-12
= Your training: allows you to register to a training session you have been invited to participate in. September 2018

SIWI World Water Week 2018 - Stockholm - 26-31
August 2018

MedRIN Kick-off Meeting - Chania - 13 & 14 July 2018

RUS Webinar - Special edition “AskRUS - Sentinel-1" - 12
July 2018

RUS Training Session - Valencia - 22 July 2018
IGARSS 2018 - Valencia - 22-27 July 2018




Click on Request a new User Service to request your RUS Virtual Machine. Complete the form so that
the appropriate cloud environment can be assigned according to your needs.

@ RUS Research and

(oenes User Support

@:E? The RUS Service ¥ The RUS Offer v The RUS Library ¥ The RUS Community ¥ g Your RUS service ¥

Hello, Miguel 3

You are here: Home > Your RUS service > Your dashboard

v Your dashboard

® Request a new User Service 6} Chat with Support Desk

Copyright © 2017 Research and User Support

ContactUs Termsand conditions ~ Glossary ~Acronyms FAQ

If you want to repeat this tutorial (or any previous one) select the one(s) of your interest in the
appropriate field.

v User Support Request

Step 1/3 Your experience

Please help us learn more about your background by answering a few questions. This
information will be stored in your User Profile.

How many years of experience in Remote Sensing do you have?

Choose one item... v

Have you already downloaded Copernicus data via the Copernicus Open access hubs?
® Yes

- No

Have you already handled/processed Copernicus data?
® Yes

No

Do you wish to practice a tutorial exercise shown in a RUS webinar? If yes, please select your choice
(hold down CTRL key for multiple selections).

HAZAO1 - Flood Mapping in Malawi

HAZAOZ2 - Burned Area Mapping in Portugal

HYDRO1 - Water Bodies Mapping over Northern Poland
LANDO1 - Crop Mapping in Seville

LANDO4 - Land Monitoring in Cyprus

OCEAO1 - Ship Detection in Gulf of Trieste v

-

If you wish to request another tutorial exercise that doesn’t appear in the above list, please type here
its name or code. Note that you can request multiple tutorial exercises.

Complete the remaining steps, check the terms and conditions of the RUS Service and submit your
request once you are finished.



* User Support Request

Summary information on your request:

This is a collection of information selected across the USR forms.
You can go back and edit this information if necessary.

General information on your request:

“Years of experience in Remote Sensing 5-10vyears

Downloaded Copernicus data? J
Handled/processed Copernicus data? J
Webinar codes HAZADZ, LANDOS

About your RUS project:

Thematicarea Cryosphere (ice and snow)
Orperations to perform on RUS Algorithm development
Preference for downloading process Self-downloading
Foreseenactivities and support needs Develop 2land cover dassification
Project name RUS Project1

Earth Observation Data information:
Type of Earth Observation Data:
Sentinel-1 <
51-Product 1

51 - Product type GRD
51 - Sensor mode
51 - Polarisation
51 - Orbit direction

Sentinel-2 X
Sentinel-3 X
Other x

1 don’t know X

Region of interest:

Min Latitude 39.3303
Max Latitude 405877
Min Longitude -4 6736
Max Longitude -27205
Reference polygens

Data acquisition date(s):
None
Additional data specifications

® | have read and agree to the Terms and conditions of RUS Service.

Further to the acceptance of your request by the RUS Helpdesk, you will receive a notification email
with all the details about your Virtual Machine. To access it, go to Your RUS Service = Your Dashboard
and click on Access my Virtual Machine.

@; R U Research and

(Geenes User Support

@E? The RUS Service v The RUS Offer ¥ The RUS Library ¥ The RUS Community ¥ g Your RUS service ¥
You are here: Home > Your RUS service > Your dashboard

Hello, Miguel 2

% Request a new User Service Q Chat with Support Desk

a Date of q o q

Project Name ID i Status Actions Virtual Environment
: submission
. N Access my CPU
Follow my project Get support Close my service monitoring dashboard
RUS_training1 231 | 2017-08-31 Open
Get a webinar kit Rate my service Freeze my Virtual Report a technical
Y % A ok Machine(s) incident
Copyright ® 2017 Research and User Support ContactUs  Terms and conditions ~ Glossary ~Acronyms FAQ




Fill in the login credentials that have been provided to you by the RUS Helpdesk via email to access

your RUS Copernicus Virtual Machine.

C A Notsecure = https://usr-231.rus-copernicus.eu/#/

APACHE GUACAMOLE

| Username

S

| Password

8

This is the remote desktop of your Virtual Machine.

5 Step by step

5.1 Data download — ESA SciHUB

In this step, we will download the Sentinel-1 scenes from the Copernicus Open Access Hub using the

online interface. Go to Applications = Network - Firefox Web Browser or click the link below.

Go to https://scihub.copernicus.eu/



https://scihub.copernicus.eu/

Welcor Copernicus Open Access Hub orts & Stats

Data upda

@ 43,729

prod. published in the last 24h

The Copernicus Open Access Hub (previously known as Sentinels Scientific Data Hub) provides complete, free and open access to
Sentinel-1, Sentinel-2, Sentinel-3 and Sentinel-5P user products, starting from the In-Orbit Commissioning Review (IOCR).

Sentinel Data are also available via the Copernicus Data and Information Access Services (DIAS) through several platforms .

Please visit our User Guide for getting started with the Data Hub Interface. Discover how to use the APIs and
create scripts for automatic search and download of Sentinels’ data.

Latest update: see the section on Long Term Archive for the upgrade of the interfaces for access to offline data.

!_ 140,986

downloads in the last 24h
(Scub + AP Hub +
1e0ps + 5-5P Pre0ps)

g Reports

For further details or requests of support please send an e-mail to eosupport@copericus.esa.int

Go to “Open HUB”, if you do not have an account please register by going to “Sign-up” in the LOGIN

menu in the upper right corner.

Please login to access our
services...
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After you have filled in the registration form, you will receive an activation link by e-mail. Once your
account is activated or if you already have an account, “LOGIN”.

Navigate to Hawaii (approximate area — green rectangle).

.

FHagstan, Abuguerud
e L Pcaty 2

Zoom in to the south-east part of the Hawaii Island, switch to “drawing mode” and draw a search
rectangle approximately as indicated below. Open the search menu by clicking to the left part of the
search bar and specify the following parameters:

Sensing period: From 2018/04/23 to 2018/05/05

Select: Mission: Sentinel-1

Product Type: SLC

Sensor Mode: W

Relative Orbit Number: 87 (It is important for InSAR processing since we need the products to have
the same geometry).

» Sort By: » Order By:

Ingestion Date Descending

» Sensing period

20180423 20180505

» Ingestion period

e Mission: Sentinel-1

Satellite Platform Product Type

B e

Polarisation Sensor Mode

87 [
o Mission: Sentinel-2

satellite Platform Product Type

i
Relative Orbit Number (from 1 to 143) Cloud Cover % (e.g.[0 TO 9.4])

Then click on the “Search” icon. In our case, the search returns 2 results for the time period we set.
Download both scenes by clicking on the “Download Product” icon:

S1B IW_SLC__1SDV_20180423T161524 20180423T161551_010613_0135DD_33F0
S1B IW_SLC__1SDV_20180505T161525_20180505T161552_010788_013B7D_25D2
11



Opermicus Copernicus Open Access Hub

Display 1 to 2 of 2 ]

products. 0 products [u]
Order By: Ingestion Date selected
+

804962007
41,-155.05102056652606
962007 19.460888118669033,

_15DV_20180505T161525_20180505T161552_010788_0138... O
ptinel.1 Instrument: SAR.C Sensing Dote: 2018.05.05T16:15:25.226Z

+ ® W

IEE Sl s16 iw_SLC_ 15DV 20180423T161524_20180423T161551 010613 0135... CRSSREIEEERT

Products per page: (NN | L]

The products will be downloaded at /home/rus as zip files. Move them to:
/shared/Training/HAZAO05_EarthquakeDeformation_Hawaii_TutorialKit/Original folder.

5.2 SNAP —open and explore data

Open SNAP software from the icon located on the desktop 3 or go to Applications = Processing 2>
SNAP Desktop. Click the Open Product icon E, navigate to:
/shared/Training/HAZAO05_EarthquakeDeformation_Hawaii_TutorialKit/Original folder and open
the two S-1 downloaded products (first the 20180423 and then the 20180505):

S1B_IW_SLC__1SDV_20180423T161524_20180423T161551_010613_0135DD_33FO0.zip
S1B_IW_SLC__1SDV_20180505T161525_20180505T161552_010788_013B7D_25D2.zip

The opened products will appear in Product Explorer window. Click + or @ to expand the contents of
product [1] from 23 April 2018, then expand Bands folder and double click on Intensity_IW1_VV band
to visualize it in the View window. You can go to the World Map tab and zoom in to see the location
of the opened product on the globe (See " INOTE 1).

] SNAP View = SoenieRatd

Fle Edt View Analysis Layer Vector Raster Optical Radar Tools Window Help Q:
Q Per @O Ivlf | @B H 5 W o ulq/w;\r/Dﬁ):
Explorer- -

\ W o ’ =
<= Product




Open the Intensity_IW1_VV band of the product [2] from 5 May 2018 as well and compare them by
going to Window - Tile Horizontally. Go to the Navigation tab and click on the two icons shown
within the red rectangular below to synchronize the views and the cursor position between the views.

m SNAP [

File Edt View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
a% Fdd PR Aor Al @12 = D 2 LB s 0QAZI\NDR D
7

W (@ (1) Intensity_WLW x

NOTE 1: The RADAR instrument onboard Sentinel-1 carries an antenna that is looking always to the right
during its pass. These two scenes were acquired during descending pass (the satellite was moving in
direction from north to south) and in this case while looking to the right it was actually looking towards
the west. That is why we see that the view of the image appears as if “mirrored”, because the view
shows the pixels in order of the data acquisition.

5.3 Pre-processing

We need to apply identical pre-processing steps to both products and we will use the GraphBuilder
and the Batch Processing tools.

By using the GraphBuilder tool, we can define the steps of the process we want to apply and at the
end only the final product will be physically saved (this way we will also save disk space since the
products of the intermediate steps will not be stored).

By using the Batch Processing tool, we will apply all steps to both images in one go.
5.3.1 Graph Builder
Go to Tools = GraphBuilder to build our graph.

We can see that the graph has only two operators: Read (to read the input) and Write (to write the
output). Below there also are the corresponding to the operators’ tabs.

First, right-click on the Write operator and Delete it. The corresponding tab will be removed as well.
This is to avoid confusion to the sequence of the graph. The Write operator will be added again at the
end.

For now, we will not define any parameters in the tabs (they will be defined in the Batch Processing
step), we will only create the graph.

13



File Edt View Analysis Leyer Vector Rester Optical Reder Tools Wind(as—
’ Graph Builder sl

Right click hare to add an operator

@

Every Interferometric Wide swath (IW) consists of 3 sub-swaths and each one of maximum 9 bursts.
In SNAP we can process only one swath at a time until the Deburst step (See chapter 5.4.3). Our area
of interest is located in the IW1 and is covered sufficiently by processing 2 bursts. We will use the
TOPSAR-Split operator; this way we will reduce the total processing time (See " INOTE 2).

To add the TOPSAR-Split operator, right-click at the empty white space right of the Read operator and
go to Add - Radar = Sentinel-1 TOPS = TOPSAR-Split. Connect the Read operator to it by dragging
the red arrow from the right side of Read operator towards the TOPSAR-Split operator.

Read |—-={ TOPSAR-Split

NOTE 2: In this case that we are using a pair of descending products, the IW1 is the one to the east. If
we work with ascending products, the IW1 is the one to the west. Depending on our area of interest,
we can process some or all bursts of a sub-swath, or even merge more sub-swaths but this will be quite
time consuming and computationally heavy in the following steps.

Now we will add the Apply-Orbit-File operator by right-clicking and going to Add - Radar 2> Apply-
Orbit-File (See " INOTE 3). Connect the TOPSAR-Split operator to it.

Read |— > TOPSAR-Split s Apply-Orbit-File

NOTE 3: The orbit state vectors provided in the metadata of a SAR product are generally not accurate
and can be refined with the precise orbit files which_are available days-to-weeks after the generation of
the product. The orbit file provides accurate satellite position and velocity information. Based on this
information, the orbit state vectors in the abstract metadata of the product are updated.

Finally, we will add the Write operator to write our output product. To add the operator right-click
and go to Add = Input-Output = Write. Connect the Apply-Orbit-File operator to it.

Read |——=i TOPSAR-Split —>4 Apply-Orbit-File |—> Write

14



Then click on icon at the bottom of the Graph Builder window and save the graph under
/shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing folder with the
name Preprocess_Graph.xml.

B SNAP - Save Graph 40 x
Save In: |[] Processing v| |H| |5 || |85 )e=
- D;
Name
[ [] shared
[ Training
[C] HAZADS_EarthquakeDeformation_Hawaii_TutorialK
[ Processing

File Name: |Preprocess Graph.xml

Files of Type: |Graph (*.xml) -

Save Cancel

Close the Graph Builder window.

5.3.2 Batch Processing

Batch Processing is used when we want to apply identical pre-processing steps at once, to multiple
images (in this case only in two). Open the Batch Processing tool by going to Tools = Batch Processing.

In the 1/O Parameters tab we will add both opened products from the Product Explorer window by
clicking Add Opened at the right (second icon from the top) and then click Refresh (second icon from
the bottom). Deselect the “Keep source product name” option.

Then we will click on Load Graph at the bottom of the window, navigate to our saved graph and open
it. We see that new tabs have appeared at the top of window corresponding to our operators.

] Batch Processing : Preprocess_Graph.xml AR
File Graphs
1/0 Parameters TOPSAR-Split i Apply-Orbit-File | Write \
| File Name Type \ Acquisntion: Track : Orbit c.{};
{S1B_IW_SLC__1SDV_20180423T16152... .SLC 23Apr2018 87 {10613 —
[S1B_W_SLC__1SDV_20180505T16152... |SLC |o5Mayz018 |87 [10788 + == Add Opened
JEL
\ 4
fS < Refresh
%
| 2 Products
Target Folder
Save as: !
Directory:
Skip existing target fileslf | Keep source product namel
I Load Graph Il Run I Close H Help I
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In the TOPSAR-Split tab Zoom in to the product and choose:

Subswath: IW1
Polarisations: VV
Bursts: 4 to 5 (drag the two sliders accordingly)

L- Batch Processing : Preprocess_Graph.xml +

File Graphs

IfO Parameters I TOPSAR-Split I Apply-Orbit-File | Write

Subswath: w1 -

Polarisations: wvH
AV
Bursts: 4 to 5 (max number of bursts: 9)

Y 700m in

In the Apply-Orbit-File tab we will keep the default settings and make sure that you will select the “Do

not fail if new orbit file is not found” option.

L- Batch Processing : Preprocess_Graph.xml Lo (o]

File Graphs

/O Parameters | TOPSAR-Split II Apply-Orbit-File I Write

Orbit State Vectors: |gentinel Precise (Auto Download) -

Polynomial Degree: |3

I v| Do not fail if new orbit file is not foundl

In the Write tab keep the “Name” that is created with the “Orb” suffix and under the “Directory” set
the path to /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

folder. Then click Run.

_I Batch Processing : Preprocess_Graph.xml =]

File Graphs

I/O Parameters | TOPSAR-Split | Apply-Orbit-File

Target Product

Name
S1B_IW_SLC_ 1SDV_20180423T161524_20180423T161551_010613 0135DD_33F0_Orb
— —

Save as: |BEAM-DIMAP -
Directory:

/shared/Training/HAZAOS_EarthquakeDeformation_Hawaii_TutorialKit/Processing
= =

Load Graph | Run Close Help
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Now close the Batch Processing window, collapse the products [1] and [2] and close the opened View
windows as well. The two new products have appeared to the Product Explorer window. Expand the
products [3] and [4], expand the Bands folder and double click on the Intensity_IW1_VV band.

m SNAP [P

Ede Edt View Analysis Layer Vector Raster Optical Rader Jools Window Help Q-

ag Fdd| P2 Aer OOl @ % XEBw 0 QAAIN\NDTERD:

Prod S| @ (3] Intensity_WLW x 4 ¥/=0) (W19 intensity_WI_W x DI
s
=
v
4

Nevigation S 4JI] Colour Manipulati... | Uncertainty Visual... | Worid Map ]
o
3
x

Lat Lon Zoom ~ Level @

5.4 Coregistration and Interferometric Processing

5.4.1 Data Coregistration

Image coregistration is the alignment of master and slave images; the pixels of the slave images
correspond to those of the master and represent an identical area.

Let’s open again a GraphBuilder window. Go to Tools = GraphBuilder. We can see that the graph has
only two operators: Read and Write and below there also are the corresponding to the operators’
tabs.

File Edn iew Analysis Layer Vector Raster Optical Radar Iools Windfs s Q-
[_- Graph Builder [F+ 0"
g L \ - o ocp .
a b AP L[ e oo 0 AGINTVER Y-

WL x Jrviol[g
E
loht click harato dd an operstor [weee] g
z
=
S
3
41 0| =

Read | write
Source Product o
Name -1
[3] S1B_W_SLC__15DV_20180423T161524_20180423T161551_010613_013500_33F0_Orb - S
DataFormat.  [Any Format |+ -

B ot | (yseve | %y ciear | [ wete | © e ‘ [> fun
1 = 1

X -v - Lt - Lon - Zoom - Level - (@

First, right-click on the Write operator and Delete it. This time, we will also define in parallel the
parameters in the tabs.
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Right-click and delete

the operator ™~ Write

Read Right click here to add an operator

Now, add one more Read operator. Right click and go to Add = Input-Output = Read. The inputs will
be the products we want to coregister.

Read(2)

In the Read tab choose the product [3] that contains only the 2 bursts of IW1 swath with updated
orbits: S1B_IW_SLC__1SDV_20180423T161524_20180423T161551_010613_0135DD_33F0_Orb

| Read Read(2) |

Source Product
Name:

[3] S1B_IW_SLC_ 1SDV_20180423T161524 20180423T161551 010613_0135DD_33F0 Orb -l ...

Data Format: Any Format |w

In the Read(2) tab choose the second product [4] as well that contains only the 2 bursts of IW1 swath
with updated orbits:
S1B_IW_SLC__1SDV_20180505T161525_20180505T161552_010788_013B7D_25D2_Orb

_ Read Readi2)

Source Product

Name:
S1B_IW_SLC_ 15DV_20180505T161525_20180505T161552_010788_013B7D_25D2_0Orb v.
Data Format: .Any Farmat .v-

5.4.1.1 Back-Geocoding

Now we will coregister the two products by using their orbits and a DEM. To add the Back-Geocoding
operator right-click and go to Radar - Coregistration = S-1 TOPS Coregistration 2 Back-Geocoding.
Connect both Read and Read(2) operators to it.

Back-Geocoding

In the Back-Geocoding tab set:

Digital Elevation Model: SRTM 1Sec HGT (Auto Download) (See " INOTE 4).
DEM Resampling Method: BILINEAR_INTERPOLATION
Resampling Type: BILINEAR_INTERPOLATION
Select the “Output Deramp and Demod Phase” option as well (See " I NOTE 5).
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|| Read | Read(2) | Back-Geocoding |

Digital Elevation Model: [SRTM 1Sec HGT (Auto Download) l-
DEM Resampling Methad: |BICUBIC_INTERPOLATION |v
Resampling Type: [BISINC_S_POINT_INTERPOLATION [v

Mask out areas with no elevation

Cutput Deramp and Demod Phasel

"] NOTE 4: We will use the SRTM 1Sec HGT (Auto Download) which has ~30m resolution instead of the
default SRTM 3sec (Auto Download) which has ~90m resolution, but this will increase the processing
time. In case you want to process more than 2 images simultaneously and you do not have enough
RAM, you can use the SRTM 3sec (Auto Download) DEM.

NOTE 5: The “Output Deramp and Demod Phase” option is necessary when Enhanced Spectral Diversity
is following.

5.4.1.2 Enhanced Spectral Diversity

This Enhanced Spectral Diversity operator follows the Back-Geocoding operator, it first estimates a
constant range offset for each burst using a small block of data in the center of the burst and then it
estimates a constant azimuth offset. Finally, the estimates from all bursts are averaged to get the final
constant range and azimuth offset for the whole image.

To add the Enhanced-Spectral-Diversity operator right-click and go to Radar = Coregistration = S-1
TOPS Coregistration = Enhanced-Spectral-Diversity. Connect the Back-Geocoding operator to it (See

¢ TIP 1)

| Back-Geocoding |»—)| Enhanced-Spectral-Diversity

In the Enhanced-Spectral-Diversity tab keep all the default parameters.

[ Read | Read(2) | Back—GeocodlngI Enhanced-Spectral-Diversity ﬂ

Registration Window Width: 512 |v|
Registration Window Height: .512 |v|
Search Window Accuracy in Azimuth Direction: |16 |v|
Search Window Accuracy in Range Direction: .16 |v|
Window oversampling factor: .128 |v|
Cross-Correlation Threshold: 0.1
Coherence Threshold for Outlier Remowval: [ 0.15|
Number of Windows Per Overlap for ESD: 10|

[ JUse user supplied shifts (please enter them below)

The overall azimuth shift in pixels: 0.0

The overall range shift in pixels: 0.0|

:@i TIP 1: If you want to coregister only two Sentinel-1 images and save the stack product created, you can
replace all steps of chapters 5.3 until 5.4.1.2 by going to: Radar = Coregistration = S1 TOPS
Coregistration = S-1 TOPS Coregistration with ESD.
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5.4.2 Interferogram Formation

Let’s create the interferogram of the two images used for the stack product. To add the Interferogram
operator right-click and go to Add = Radar = Interferometric = Products = Interferogram. Connect
the Enhanced-Spectral-Diversity operator to it. A phase and a coherence band will be created.

| Back-Geocoding }—-| Enhan:ed-Spemal-DlversltyH Interferogram

In the Interferogram tab keep the default parameters and set as Coherence Range Window Size: 18.
The Coherence Azimuth Window Size will automatically change to 5.

[ Read | Read(2) | Back-Geocoding |'Enhanced-SpectraI-Di\rermty I interferogram |

[v] Subtract flat-earth phase

Degree of "Flat Earth" polynomial |5 -
Number of "Flat Earth" estimation points|501 -
Orbit interpolation degree |3 - |

[] Subtract topographic phase
Digital Elevation Model: |

Tile Extension [%] |

[¥] Include coherence estimation

Square Pixel []
—

Coherence Range Window Size E
5

Independent Window Sizes

Coherence Azimuth Window Size

5.4.3 TOPS Deburst

Now we will remove the “black space” between the two bursts (See " INOTE 6). To add the TOPSAR-
Deburst operator right-click and go to Add - Radar > Sentinel-1 TOPS > TOPSAR-Deburst. Connect
the Interferogram operator to it.

| Back-Geocoding }—-| Enhanced-Spectral-DIversltyH Interferogram HTOPSMI-Debuut

In the TOPSAR-Deburst tab keep the default settings (Polarizations: VV).

|| Read [ Read(2) | Back-Geocoding |'Enhanced-SpectraI-Di\rermty [ Interf‘erogramn TOPSAR-Deburst |

|P0|arlsations: w |

NOTE 6: There is overlapping information in every burst with its neighbouring ones, both in range and
azimuth direction in order to provide contiguous coverage of the ground. Until now each burst has been
processed as a separate SLC image We will merge the bursts (in azimuth direction) and preserve the
phase information as well. For the overlapping region in range, merging is done between subswaths.
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5.4.4 Write/create the product

To add the Write operator right-click and go to Add = Input-Output = Write. Connect the TOPSAR-
Deburst operator to it.

| Back-Geocoding H Enhanced-Spectral-Diversity H Interferogram |._,| TOPSAR-Deburst |—)-| Write |

In the Write tab set the following:

Name: S1B_IW1_ 20180423 Orb_stack_ifg_Deb
Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

[ Read Read(2) Back-Geocoding | Enhanced-Spectral-Diversity | Interferogram | TOPSAR-Deburst I Writel
Target Product

Name:
S1B IWl 20180423 Orb Stack Ifg Deb

Save as: |BEAM-DIMAP |v|

Directory:
|,"sha|‘ed,"Trai|1ir1gf’HAZADS EarthquakeDeformation Hawaii TutorialKit/Processing

. @Loadl :;-Save l ?‘\'l Clear l @Note l @IHeIp ‘ [, Run

Then click on icon at the bottom of the Graph Builder window and save the graph under
/shared/Training/HAZAO05_EarthquakeDeformation_Hawaii_TutorialKit/Processing folder with the
name Process_Graph_1.xml.

D Preprocess_Graph.xml

El SNAP - Save Graph ROl
Save |n: ‘|j Processing ‘V = ﬁ' =~ EE E:
| —  So—
:Name Siz% Modified
] S1B_IW SLC_ 15DV 20180423T161524 20180423 3/6/19 1:38 PM
[ S1B_IW SLC_ 15DV _20180505T161525 20180505.. 3/6/19 1:38 PM

1 KB 3/6/19 10:29 AM

File Name: |Process_':’;raph_1.>sml

Files of Type: |Graph {*.xml) -

Save Cancel

Finally, click on the " _Jicon at the bottom of the Graph Builder window. The process will be
completed in 40 minutes in a 32GB RAM VM.

[> Ru

Now close the Graph Builder window, collapse the products [3] and [4] and close the opened View
windows as well. The new product has appeared to the Product Explorer window. Expand the product
[5], expand the Bands folder and double click on the Phase_ifg_IW1_VV_23Apr2018_05May2018 and
the coh_IW1_VV_23Apr2018_05May2018 bands.
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m [5] $18_IW1 20180423 Orb_Stack _Ifg_Deb - _Hawall 1B_IW1 20180423 Orb_Stack_Ifg_Deb.dim] - SNAP [

A% DElJhd PR Poorlll ® 0 e £ = ;> KB s 0QASI\NDVE D
Product Explorer X CHE 1O fo_W1_VW_23Apr2018_05May2018 x <[ »i[wi[0] ("W (5] coh_w1_W_234 5 x ODISIEIES
o @ [1] S1B_W_SLC_1SDV_2018042 SDD 33F0 7
=
Mavigation - [S... X | Colour Manipulati. | Uncertainty Visual . | World Map L: é}
@\
Q R
@ :
>
3
- La L z L (<]
Let’s open another GraphBuilder window. Go to Tools = GraphBuilder.
Keep only the Read operator and delete again the Write operator.
In the Read tab choose the coregistered product [5] S1B_IW1_20180423_Orb_stack_ifg_Deb.
Read
Source Product
Name:
[5] S1B_IW1_20180423_Orb_Stack Ifg_Deb Iv| .

Data Format: Any Format |w

5.4.5 Topographic Phase Removal

This is to estimate and subtract the topographic phase from the deburst interferogram. To add the
TopoPhaseRemoval operator right-click and go to Add - Radar = Interferometric = Products =

TopoPhaseRemoval. Connect the Read operator to it.

| Read HTnpnPIlnlell.ernnvll

In the TopoPhaseRemoval tab set as Digital Elevation Model: SRTM 1Sec HGT (Auto Download) and
select the “Output topographic phase band” option as well.

" Read I ToeaPhaseRemovaI I

[Orbit Interpolation Degree:|3 |

Digital Elevation Model:  [SRTM 1Sec HGT (Auto Download) |v

Tile Extension [%] 100 |'

[v] Output topographic phase bandl

|_| Output elevation band

Output orthorectified Lat/Lon bands
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5.4.6  Multilooking

By applying this operator, we will reduce the inherent speckle noise that originally appears to the SAR
images and we will obtain square pixels. To add the Multilook operator right-click and go to Add >
Radar = Multilook. Connect the TopoPhaseRemoval operator to it.

‘ Read HTnpnPIlnleH.emnunl H Multilnnll:l

In the Multilook tab keep the “GR Square Pixel” option selected and set Number of Range Looks: 6.
The Number of Azimuth Looks will automatically change to 2 and the Mean GR Square Pixel to
26.533897.

Read I TopoPhaseRemoval | Multilook |

Source Bands: i_ifg_VV_23Apr2018_05May2018

q_ifg_Vv_23Apr2018_05May2018
Intensity_ifg_VV_23Apr2018_05May2018_ifg_srd_VV_23Apr2018_05May2018
Phase ifg srd VW 23Apr2018 05May2018

topo_phase W 23Apr2018 05May2018
coh_IW1_VV_23Apr2018_05May2018

¥| GR Square Pixel [ ] Independent Looks

Number of Range Looks: |6
Number of Azimuth Looks: 2
Mean GR Square Pixel: 26.533897

[ ] Output Intensity

Note: Detection for complex data
is done without resampling

5.4.7 Phase Filtering

Phase filtering reduces the phase noise (See " INOTE 7). To add the GoldsteinPhaseFiltering operator
right-click and go to Add > Radar - Interferometric - Filtering > GoldsteinPhaseFiltering. Connect
the Multilook operator to it.

| Read HTnpnPhn!ehmnunl|»—)|Multilnok|»—)-| GoldsteinPhaseFiltering

In the GoldsteinPhaseFiltering tab set the FFT Size to 128 and keep the rest parameters as by default.

Read TopoPhaseRemowal I Multilook IGoldsteinPhaseFilteringI

Adaptive Filter Exponent in (0,1]): 1.0
FFT Size: 128 |v
Window Size: 3 |v

[ |Use coherence mask

Coherence Threshold in [0,1]: 0.2

NOTE 7: It is necessary step since it will enhance the phase unwrapping accuracy for the upcoming step
(See chapter 5.4.8).

Finally we will save the product and we will also export it for SNAPHU. To add the Write operator right-
click and go to Add = Input-Output = Write. Connect the GoldsteinPhaseFiltering operator to it.
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| Read HTnpnPhnlellemmul |.—.| Mull‘llnnkH GoldsteinPhaseFiltering

In the Write tab set the following:

Name: S1B_IW1_ 20180423 Orb_stack_ifg_Deb_DInSAR_ML_Flt
Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

Read | TopoPhaseRemoval I Multilook | GoldsteinPhaseFiltering IWrite |
Target Product

Name:
S1B IWl 20180423 Orb Stack Ifg Deb DInSAR ML Flt

Save as: |BEAM-DIMAP |v'

Directory:

/shared/Training/HAZAOS EarthguakeDeforrnation Hawaii TutorialKit/Processing | |

To add the SnaphuExport operator right-click and go to Add = Radar = Interferometric =
Unwrapping = SnaphuExport. Connect the GoldsteinPhaseFiltering operator to it as well.

l Read l»—-l TopoPhaseRemoval H Multilookl»—-l GoldsteinPhaseFiltering

SnaphuExport

In the SnaphuExport tab click on =2 | icon to set the Target folder. Navigate to the following path:
/shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing and write at
the File Name: SNAPHU. Click Select.

m Select O X
Look |n: |D Processing '| llﬁ‘;ﬁ:llj‘:ﬂ:ﬂl[ﬂ:

Name |
L] S1B IwWl 20180423 Orb Stack Ifg Deb.data

(=] S1B_IW SLC_ 15DV 20180423T161524 20180423T161551 010613 0...

=2 S1B_IW SLC 15DV 20180505T161525 20180505T161552 010788 0...

D Preprocess Graph.xml

D Process _Graph_1.xml

[} s1B_w1_20180423_Orb_Stack_Ifg_Deb.dim

[}y s1B_w sLc_ 1SDv 20180423T161524_20180423T161551 010613 0...

[}y s1B_w sLc_ 1SDv 20180505T161525 20180505T161552_010788 0. ..

4] | | [ »

File Name: SNAPHU |

Files of Type: |All Files ‘v

I
I Select || Cancel
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Then define the following parameters in the SnaphuExport tab:

Initial method: MCF
Number of Tile Rows: 1
Number of Tile Columns: 1
Row Overlap: 0

Column Overlap: 0

Read | TopoPhaseRemoval I Multilook | GoldsteinPhaseFiltering IWrite II SnaphuExportI

Target folder: fshared/Training/HAZAO05 EarthquakeDeformation Hawaii TutorialKit/Processing/SNAPHU E
Statistical-cost mode: DEFO -
Initial method: MCF -
Number of Tile Rows: 1
Number of Tile Columns: 1
Number of Processars: 4
Row Overlap: 0|
Column Overlap: 0
Tile Cost Threshold: 500!

@ Load :;J Save ?‘l Clear

Click on (3 save

|Z Mote

@Help | [““ Run ‘

icon at the bottom of the Graph Builder window and save the graph under
/shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing folder with the
name Process_Graph_2.xml.

B | SNAP - Save Graph a0 x
Save In: |J Processing ‘v o ] )
Narme | SizelModiFied -
[CJ S1B_IW1_20180423_Orb_Stack_Ifg_Deb.data 3/7/19 3:53 PM
[ S1B_IW_SLC_ 1SDV_20180423T161524_20180423... 3/6/19 1:38 PM
[ S1B_IW_SLC_ 1SDV_20180505T161525 20180505, 3/6/19 1:38 PM
[ SMAPHU 3/8/19 8:29 AM
E‘] Preprocess_Graph. xml 1 KB 3/6/19 10:29 AM
D Process_Graph_l.xm| 4 KB 3/7/19 3:44 PM
File Name: |Pro(ess Graph 2. xml |
Files of Type: |Graph (*_xrnl) |v|

I Save I Cancel |

> &

Finally, click on the —Jicon at the bottom of the Graph Builder window.

Now close the Graph Builder window, collapse the product [5] and close the opened View windows
as well. The new product has appeared to the Product Explorer window. Expand the product [6],
expand the Bands folder and double click on the Phase_ifg IW1_VV_23Apr2018_05May2018,
topo_phase_VV_23Apr2018_05May2018 and the coh IW1_VV_23Apr2018 05May2018 bands.

Choose the Phase_ifg IW1_VV_23Apr2018 05May2018 band in the View window, go to Colour

10096
Manipulation tab and click on the “Auto-adjust to 100% of all pixels” icon . We can see values that
correspond to the fringes of the differential interferogram (-pi, pi). Repeat the same for the
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coh IW1_VV_23Apr2018 _05May2018 band. Coherence values vary from 0 to 1 (1 = most coherent).
] SNAP - g =%

e Y
oAl ®O I & 3 o » @ AN\ T E D
& (@ (5] Phase_tfg 3Apr2018_05M

5.4.8 Phase Unwrapping

Phase unwrapping is prerequisite to convert phase units to length units (See " INOTE 8). Open the:

g Create Folder.. /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/
4 Create D E ’
B Processing/SNAPHU/S1B_IW1_20180423 Orb_Stack Ifg_Deb_DInSAR_
ML_FIt/ folder and right-click in the empty space.

'*- Open Terminal Here

Zoom In Select “Open Terminal Here”.
Normal Size
— The following terminal will appear.

ﬁ Terminal - rus@front-usr-3304: /shared/Training/HAZAO05_EarthquakeDeformation_Hawaii_TutorialKit/Py 0 o [sl +¢
File Edit View Terminal Tabs Help
rus@front-usr-3304:/shared/Training/HAZAQ5 EarthquakeDeformation Hawaii Tutorial

Kit/Processing/SNAPHU/S1B IW1l 20180423 Orb Stack Ifg Deb DInSAR ML Flt$

In the same folder, open the snaphu.conf file.

In line 28 (go to View > Line Numbers), add the # symbol and leave a space before LOGFILE. Go to
File = Save and save the changes. Then go to line 7 and copy the command shown in the picture
below in blue, to call snaphu:

snaphu -f snaphu.conf Phase_ifg_VV_23Apr2018_05May2018.snaphu.img 3435

Paste it in the Terminal and press Enter to run it.

.Terminal-rus@front-usr-3304: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Py » ~ (sl ~¢
File Edit View Terminal Tabs Help

rus@front-usr-3304:~$%$ cd /shared/Training/HAZAG5 EarthquakeDeformation Hawaii Tu
torialKit/Processing/SNAPHU/S1B IW1l 20180423 Orb Stack Ifg Deb DInSAR ML Flt/
rus@front-usr-3304:/shared/Training/HAZAG5 EarthquakeDeformation Hawaii Tutorial

Kit/Processing/SNAPHU/S1B IW1l 20180423 Orb Stack Ifg Deb DInSAR ML Flt$ snaphu -
f snaphu.conf Phase ifg VV 23Apr2018 05May2018.snaphu.img 3435
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¢ *snaphu.conf - Mousepad 0

File Edit Search View Document Help

S G | %ol QAR

Q HABHUBBUBBRRRRERBRRARRNRH
10 # Unwrapping parameters #
L1 #HHHBHBHRERRRRA RGN

12

13 STATCOSTMODE DEFO
14 INITMETHOD MCF
15 VERBOSE TRUE
16

17 #AFHANBHRBRRHRRRH

18 # Input files #

19 HHBHBHBHBHBRRRH

20

21 CORRFILE coh_IWl VV_23Apr2018 05May2018.snaphu.img
22

23 HUHBHARBRBRRRRER

24 # Qutput files #

25 HHHBHHBHHEGHR R

26

27 OUTFILE UnwPhase_ifg VV_23Apr2018 05May2018.snaphu.img
28 # LOGFILE snaphu. lLog

29

30 SHHBHHBRAREHER T
31 # File formats #

When the processing is completed, the terminal will contain all the information, as shown below.

ﬂ Terminal - rus@front-usr-3304: /shared/Training/HAZA05_EarthguakeDeformation_Hawaii_TutorialKit/Py <» ~ (5]

File Edit View Terminal Tabs Help

Building azimuth cost arrays

Initializing flows with MCF algorithm

Setting up data structures for cs2 MCF solver

Running c¢s2 MCF solver

Running nonlinear network flow optimizer

Maximum flow on network: 14

Number of nodes in network: 4852243

Flow increment: 1 (Total improvements: 0)

Treesize: 4852243 Pivots: 6153976 Improvements: 20553

Maximum flow on network: 3

Flow increment: 2 (Total improvements: 20553)

Treesize: 4852243 Pivots: 429 Improvements: 0

Maximum flow on network: 3

Flow increment: 3 (Total improvements: 20553)

Treesize: 4852243 Pivots: 4 Improvements: 0

Maximum flow on network: 3

Total solution cost: 52239984

Integrating phase

Writing output to file UnwPhase ifg VV 23Apr2018 05May2018.snaphu.img
Program snaphu done

Elapsed processor time: 0:20:14.66

Elapsed wall clock time: 0:20:16
rus@front-usr-3304:/shared/Training/HAZAO5 EarthquakeDeformation Hawaii Tutorial
Kit/Processing/SNAPHU/S1B IW1l 20180423 Orb Stack Ifg Deb DInSAR ML Flt$

The time needed for the process to be completed depends on the characteristics of your machine. It
might take up to 30 minutes. With a 32GB RAM VM it lasted 20 minutes.

"

NOTE 8: Two-dimensional phase unwrapping is the process of recovering unambiguous phase data from

a 2-D array of phase values known only modulo 2pi rad.
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5.4.8.1 SNAPHU import to SNAP
Now we will import the results from SNAPHU processing. Go to Radar = Interferometric >
Unwrapping = Snaphu Import.

In the 1-Read-Phase tab, select the product that was created from the Write operator:
[6] S1B_IW1_20180423_Orb_Stack_Ifg_Deb_DInSAR_ML_FIt

('_ Snaphu Import [ x
1-Read-Phase 2-Read-Unwrapped-Phase [ 3-Snaphulmport | 4-Write
Source Product
Name:
[6] S1B_IW1_20180423_Orb_Stack_Ifg_Deb_DInSAR_ML_Fit -l
Data Format: Any Format |v

In the 2-Read-Unwrapped-Phase tab, click on to select the product that contains the unwrapped
phase: UnwPhase_ifg_VV_23Apr2018_05May2018.snaphu.hdr from the following path:

/shared/Training/HAZAO05_EarthquakeDeformation_Hawaii_TutorialKit/Processing/SNAPHU/S1B_
IW1_20180423 Orb_Stack Ifg_Deb_DInSAR_ML_Flt

You will see that under the Name it is written: UnwPhase_ifg VV_23Apr2018 05May2018.snaphu

(’; Snaphu Import [ X

1-Read-Phase I 2-Read-Unwrapped-Phase I 3-Snaphulmport | 4-Write

Source Product
MName

UnwPhase_ifg_VV_23Apr2018_05May2018.snaphu - D

Data Format: Any Format | w

”n

In the 3-Snaphulmport tab, select the “Do NOT save Wrapped Interferogram in the target product
option.

t; Snaphu Import [ x

1-Read-Phase | 2-Read-Unwrapped-Phase I 3-Snaphulmport | 4-Write

| v] Do NOT save Wrapped interferogram In the target product

In the Write tab, set the following:

Name: S1B_IW1 20180423 Orb_stack ifg Deb_DInSAR_ML Flt_Unw
Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

t‘. Snaphu Import (" x

1-Read-Phase 2-Read-Unwrapped-Phase 3-Snaphulmport

Target Product

Name:
S1B_IW1_20180423_Orb_Stack_Ifg Deb_DInSAR_ML_Fit Unw

Save as: BEAM-DIMAP -

Directory:
/shared/Training/HAZAOS_EarthquakeDeformation_Hawaii_TutorialKit/Processing

Click Run.
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Now close the Snaphu Import window, collapse the product [6] and close the opened View windows
as well. The new product has appeared to the Product Explorer window. Expand the product [7],

expand the Bands folder and double click on the Unw_Phase_23Apr2018_05May2018 band. In Colo
Manipulation tab you can see the absolute values of the phase.

= LD et

File Edit Yiew Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
@loLsd PR Por Al @@ e £ 3 73 XE® v 0QAINTER D

& [ @ 17] Unw_Phase_ifg_23Apr2018_05May2018 x «ivlo

Aue3a0 390p0Id

¢ & ea
B Unw_Phase_ifg_23Apr2018_05May2018

sabousy 124w @)

13beuei yseW Ky

Navigation - (7] U..._|Golour Manipul,. X Uncertainty Visuall...| World Map

[ JONS

Edtor: O Basic @ Shiders O Table

ifg_23Apr2018_0SMay2018

{104

=
buucyuow iov §

FPALPBY
ol |

g

5.4.9 Displacement

It is time to convert the interferometric phase to displacement. Go to Radar = Interferometric
Products 2 Phase to Displacement.

In the 1/O Parameters tab set the following:

As source (Input): [7] S1B_IW1_20180423_Orb_stack_ifg_Deb_DInSAR_ML_FIt_Unw
As Name (Output): S1B_IW1 20180423 Orb_stack_ifg Deb_DInSAR_ML _Flt_Unw_dsp
As Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

& Phase to Displacement ol

File Help

|/O Parameters | Processing Parameters

Source Product
source;
[7] S1B_IW1_20180423_Orb_Stack_Ifg_Deb_DInSAR_ML_Fit_Unw Iv l:l

Target Product
Name:
S1B Wl 20180423 Orb Stack Ifg Deb DInSAR ML Flt Unw dsp

e
[v] Save as: |BEAM-DIMAP |~

Directory:
\!sharedﬂ'raining!HAZAUS EarthguakeDeformation_Hawaii_TutorialKit/Processing El

[v] Open in SNAP

Click Run since there are no parameters in the Processing Parameters tab to be changed.

ur

>
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Now close the Phase to Displacement window, collapse the product [7] and close the opened View
window as well. The new product has appeared to the Product Explorer window. Expand the product
[8], expand the Bands folder and double click on the displacement band.

Click on the “Import colour palette from text file” icon ==, and open the Displacement.cpd colour
palette from: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/AuxData
folder.

ﬁ SNAP [T

Fle Edt View Analysis Leyer Vector Raster Optcal Radar Tools Window Help Q-
Fdd| P =R B er W ©I® w = = 3 HNB® roQAINTR D

S (@ (8] displacement x

PNposd

@ displacement

e

“

136908

Navigation - (8] di._. | Colour Manipul.. X Uncertainty Visuali

Editor: O Basic ® Sliders () Table

oo 10V §

6t

Lat Lon Zoom -+ Level

5.5 Geocoding

We will apply the Terrain Correction in the product containing the unwrapped interferogram and then
to the one containing the displacement as well, to convert the RADAR coordinates into geographic.

Go to Radar = Geometric = Terrain Correction = Range-Doppler Terrain Correction.
In the 1/O Parameters tab set the following:

As source (Input): [6] S1B_IW1_20180423_Orb_stack_ifg_Deb_DInSAR_ML_FIt
As Name (Output): S1B_IW1 20180423 Orb_stack ifg Deb DInSAR_ML FIt_ TC
As Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

(‘. Range Doppler Terrain Correction =l
File Help

| /0 Parameters | Processing Parameters |

Source Product

source:

|[s] S1B_IW1_20180423_Orb_Stack_fg_Deb_DInSAR_ML_Fit -

Target Product
Name

S1B IWl 20180423 Orb Stack Ifg Deb DInSAR ML Fit TC

|v]| Save as: |BEEAM-DIMAP -
Directory:

fshared/Training/HAZADS EarthquakeDeformation Hawaii TutorialKit/Processing |

l¥] Open in SNAP

In the Processing Parameters tab set the following:
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In Source Bands select only:

Intensity_ifg_ VV_23Apr2018_05May2018
Phase_ifg_VV_23Apr2018_05May2018
topo_phase_VV_23Apr2018 05May2018
coh_IW1_VV_23Apr2018 05May2018

In Digital Elevation Model: SRTM 1Sec HGT (Auto Download)

t‘- Range Doppler Terrain Correction \ o x
File Help

I/0 Parameters | Processing Parameters |

Source Bands i_ifg_VV_23Apr2018_05May2018

Intensity_ifg_VW_23Apr2018_05May2018
Phase_ifg_VW_23Apr2018_05May2018

topo_phase_VV_23Apr2018_05May2018
coh IWl VW 23Apr2018 05May2018

Digital Elevation Model: |SRTM 1Sec HGT (Auto Download) Iv|
DEM Resampling Method: ‘BILINEAR_INTERPOLATION |v|
Image Resampling Method ‘BILINEAR_INTERPOLATION Iv|
Source GR Pixel Spacings (az x rg):  28.02(m) x 25.05(m)

Pixel Spacing (m): [28.02 |
Pixel Spacing (dea) [2.5170794261028995E4 |
Map Projection: ‘ WGSB4(DD) |

[w] Mask out areas without elevation [ | Output complex data
Output bands for;
[¥] Selected source band [ ] DEM [] Latitude & Longitude

|| Incidence angle from ellipsoid [ | Local incidence angle [ | Projected local incidence angle

[] Apply radiometric normalization

O 0 ba

|
Qswvecommaobnd | |
O I

liary File 3 | |

Keep the rest parameters as by default. Click Run.
Repeat the same for the displacement product as well.

In the 1/O Parameters tab set the following:

As source (Input): [8] S1B_IW1 20180423 Orb_stack ifg Deb_DInSAR_ML_FIt_Unw_dsp
As Name (Output): S1B_IW1 20180423 Orb_stack ifg Deb DInSAR_ML Flt_Unw_dsp TC

As Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

t‘- Range Doppler Terrain Correction 4+ o X
File Help

I/ Parameters | Processing Parameters |

Source Product
source:

| [8] S1B_IW1_20180423_Orb_Stack_Ifg_Deb_DInSAR_ML_Fit_Unw_dsp |

Target Product
Name
[S1B_w1_20180423_Orb_Stack_ifg_Deb_DInSAR_ML_Fit_Unw_dsp_TC

e
[¥] Save as: |BEAM-DIMAP v

Directory:
/shared/Training/HAZA0S EarthquakeDeformation Hawaii TutorialKit/Processing |

[w] Open in SNAP
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In the Processing Parameters tab set the following:

In Source Bands select: displacement
In Digital Elevation Model: SRTM 1Sec HGT (Auto Download)

t‘_ Range Doppler Terrain Correction o X

File Help

" 1/0 Parameters | Processing Parameters [

Source Bands: displacement

Digital Elevation Model |SRTM 15ec HGT (Auto Download) v|
DEM Resampling Method: [BILNEAR_INTERPOLATION v
Image Resampling Method |B|LINEAR_\NTERPOLATION .'|
Source GR Pixel Spacings (azx rg); 28.02(m) x 25.05(m)

Pixel Spacing (m): |28 02

Pixel Spacing (deg): |2.5170?94261028995E4

Map Projection: | WGS84(DD) |

[w] Mask out areas without elevation [ ]| Output complex data
Output bands for:
[¥] Selected source band [] DEM [] Latitude & Longitude

[ | Incidence angle from ellipsoid [ | Local incidence angle [ | Projected local incidence angle

[] Apply radiometric normalization
O |
O |
O

Bun Close |

Keep the rest parameters as by default. Click Run.

Now close the Range Doppler Terrain Correction window, collapse all products and close the opened
View windows as well. The two new products have appeared to the Product Explorer window. Expand
the products [9] and [10], expand the Bands folder and double click on the bands you want to visualise
(e.g. coh_IW1_VV_23Apr2018_05May2018 band of product [9]).

m SNAP VeivbOfedie

Ble Edt View Analysis Layer Vector Raster Optical Radar Tools Window Help a-
a 4 b d PR Ber OBl X D 3 8 NEBx r0QAAGNTR D

& ([ (5] coh_W1_VV_23Apr2018_05May2018 x

<r|>D

Product Explore:
o @ [1]S18
-@ 125

LR AN

e Y Y YT ddy

[
14
s

R

coh_IW1_W_23Apr2018_05May2018
B_IW1_20180423_Orb_Stack_Ifg_Deb_DInSAR_ML_Fit_Unw_dsp_TC

Navigation - (8., | Colour Manipulatio . | Uncertainty Visual... | World Map

G FYIAE
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As you can see, although at the Range Doppler Terrain Correction step the option “Mask out areas
without elevation” was selected, we still have pixels that correspond to sea. This is because we used
SRTM 1sec DEM with 30m resolution.

5.6 Masking
To mask out the sea from both geocoded products, go to Raster = Masks = Land/Sea Mask.
In the 1/O Parameters tab set the following:

As source (Input): [9] S1B_IW1 20180423 Orb_stack_ifg Deb_DInSAR_ML_Flt_TC
As Name (Output): S1B_IW1_ 20180423 Orb_stack_ifg Deb_DInSAR_ML_FIt_TC_msk
As Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

(—_ Land/Sea Mask el §
File Help

I/O Parameters | Processing Parameters |

Source Product
source:

[9] S1B_IW1_20180423_Orb_Stack_Ifg_Deb_DInSAR_ML_Fit_TC -

Target Product
Name:
S1B IWl1 20180423 Orb Stack Ifg Deb DINSAR ML Fit TC msk

[v] Save as: |BEAM-DIMAP |

Directory:
Jshared/Training/HAZAOS EarthquakeDeformation Hawaii TutorialKit/Processing

[v] Open in SNAP

In the Processing Parameters tab select the “Mask out the Sea” option.

Click Run.
(—_ Land/Sea Mask 4+ 0 X
File Help

IfO Parameters I Processing Parameters I

Source Bands: Intensity_ifg_VV_23Apr2018_05May2018
Phase_ifg_VV_23Apr2018_05May2018

topo_phase_VV_23Apr2018_05May2018
coh_IW1_VV_23Apr2018_05May2018

) Mask out the Land

® Mask out the Sea

[¥] Use SRTM 3sec

_) Use Vector as Mask

[=

Extend shoreline by [pixels]: o

Repeat the same for the displacement product as well.

In the 1/O Parameters tab set the following:

As source (Input): [10] S1B_IW1_ 20180423 Orb_stack_ifg Deb_DInSAR_ML_Flt_ Unw_dsp_TC
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As Name (Output): S1B_IW1_ 20180423 Orb_stack_ifg_Deb_DInSAR_ML_Flt_Unw_dsp_TC_msk
As Directory: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing

In the Processing Parameters tab select the “Mask out the Sea” option. Click Run.

Now close the Range Doppler Terrain Correction window, collapse all products and close the opened
View windows as well. The two new products have appeared to the Product Explorer window. Expand
the products [11] and [12], expand the Bands folder and double click on the bands you want to
visualise (e.g. coh_IW1_VV_23Apr2018_05May2018 band of product [11]).

m SNAP VsivtOsfedue

Ble Edt View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
ag S hd PR Ber l ®@® = | B 3 8 NEB® rO0AASGNTR Y

3 (@ (1) coh_W1_W_23Apr2018_05May2018 x r o

Navigation - (1] .. | Colour Manipuli X | Uncertainty Visusli. | World Map

Editor () Basic ® Sliders () Table

iBo

® 27
BeRNeE| e~

3

(]

Lat Lon Zoom - Level

5.7  Export products

Now we will export the bands we want to visualise in QGIS, in GeoTIFF format. Select the appropriate
band from the Product Explorer window. Go to File > Export > GeoTIFF.

Set in Save In: /shared/Training/HAZAO5_EarthquakeDeformation_Hawaii_TutorialKit/Processing
path and click on “Subset”.

E‘ SNAP - Export Product o X
Save In: | Processing | |@E| |5 I E.
MName SiszModified I Subset... I
[C] S1B_IW1_20180423_Orb_Stack_Ifg_Deb data 3/7/19 3:53 PM =
[C7 S1B_IW1_20180423 Orb_Stack Ifg_Deb_DInSAR. .. 3/8/19 8:32 AM
O] S1B_IW1_20180423 Orb_Stack Ifg_Deb_DInSAR. .. 3/8/19 2:37 PM
[C7 S1B_IWl_20180423 Orb_Stack Ifg_Deb_DInSAR. . 3/8/19 3:24 PM
[ S1B_IWl_20180423 Orb_Stack Ifg_Deb_DInSAR. . 3/8/19 11:38 AM
[ S1B_IWl_20180423 Orb_Stack Ifg_Deb_DInSAR. . 3/8/19 1:28 PM
[ S1B_IWl_20180423 Orb_Stack Ifg_Deb_DInSAR. .. 3/8/19 2:58 PM
[ S1B_IWl_20180423 Orb_Stack Ifg_Deb_DInSAR. .. 3/8/19 3:24 PM
(9 S1B_IW_SLC__1SDV_20180423T161524_201804 3/6/19 1:38 PM
(3 S1B_IW_SLC__1SDV_20180505T161525_201805 3/6/19 1:38 PM
[ SMAPHU 3/8/19 8:32 AM -

File Name: Coherence Hawaii.tif
e
Files of Type: |GeoTIFF product (* tif * tiff) |v|
I Export Product I Cancel l
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Go to Band Subset tab and select only the band you want to export, e.g. from S1B_IW1_20180423 _
Orb_stack_ifg_Deb_DInSAR_ML_FIt_TC product, select the coh_IW1_VV_23Apr2018 05May2018
band and click OK. Set as File Name: Coherence_Hawaii.tif

m Specify Product Subset (=
Spatial Subset Metadata Subset |

[ ] Intensity_ifg_ VW_23Apr2018_05May2018 letensity from complex data
Phase_ifg WVW_23Apr2018_05May2018  Phase from complex data

topo_phase_WW_23Apr2018_05May2018 topographic_phase

15+ \coh W1 v 23Apr2018 05Mayzo18]

| |select all [ | Select none

Estimated, raw storage size; 6.6M

I 0K I Cancel I Help

Repeat for any band you want to export.

6 Visualization in QGIS

Open QGIS Desktop application. In the Browser Panel, navigate to /shared/Training/HAZAO5_Earth
quakeDeformation_Hawaii_TutorialKit/Processing folder and add the Coherence_Hawaii.tif. Right-
click on it, go to Transparency tab, set the “Additional no data value” to 0 to remove the black area

of the layer. In order to visualize better the results, set the Global Transparency to e.g. 40% and click
OK.

Layer Properties - Coherence_Hawaii | Transparency =3
N ¥ Global transparency I+ No data value
I 2t va + defi
. | I” No datavalue: not defined
§ style -
None 40% Fullf| | Additional no data value [0
E Transparency !
v C tr parency options
& Pyramids Transparency band | =]
IE=® Histogram Transparent pixel list
fi Metadat From | Tol Percent Transparent | il
etadata
2
Legend
=
o1
Style -I I oK I Cancel I Apply | Help |

Also, go to the Auxdata folder and add the Geology_Hawaii.shp and Faults_Hawaii.shp. You can
select which layers you want to be activated and arrange then in the desired order.

Activate the Geology_Hawaii.shp, right-click on it and go to Properties. In the Style tab select:

Categorized, in Column: AGE_RANGE, then click Classify and finally OK. You can also select other
category in the Column field to classify the data or set a specific Color ramp.
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Layer Properties - Geology_Hawaii | Style

General

IE- Categorized
——

Column abc AGE_RANGE

Symbol

e

[l change... |

Color ramp |Randurn colors

=l Edit | I~ Invert

& * Renderi ng Symbol T | Value Legend N
0-500yr  0-500 yr
@ oisplay 1.500-3.... 1,500-3,000 yr

11,000-3... 11,000-30,000 yr
13,000-3... 13,000-30,000 yr
200-400 yr 200-400 yr
200-750 yr 200-750 yr
3,000-5,... 3,000-5,000 yr
30,000-7... 30,000-70,000 yr
400-750 yr 400-750 yr
5,000-11... 5,000-11,000 yr
500-3,00... 500-3,000 yr

x TEN.Y BN TEN.T KON ur

'Eilil Delate all |

[¥] Layer rendering
Layer transparency _t

@ Actions
% Joins
|n Diagrams

G' Metadata

INNEEEEEEEER

=l

Advanced

Variables

Legend

Layer blending mode
Feature blending mode
™ Draw effects

2l

™ Control feature rendering order

Style

S

.:/ QGIS 2.18.23 - Hawaii

apply | welp |

e
Project Edit View Layer Settings Plugins Vector Raster Database Web dzetsaka Processing Help
IDEBRELERNIULLLARPPABIRec- K-8 -G EHE=-. T8
12/BRo-Bra <0 0l=0FR %% 55wl b4 L% 6]
|Browser Panel & x Processing Toolbox & X

LevT*o
9 G_HAZA03_Landsubsidence_Mea

{5 G_LANDO4_LandMonitoring_Cyf
5 HAZAO1_FloodMapping_Malawi_
5 HAZA02_BurnedArea_Portugal_
5 HAZA04_ActiveFire_Portugal_Tu
{5 HAZAO5_EarthquakeDeformatic
& AuxData

& Recently used algorithms
W Clip raster by mask layer
® Clip raster by extent
& Clip vectors by extent
Z Reproject layer
¢ rmask.vect - Creates a MASK for.
w Clip

Vo
",
A
@ -
(704
@
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& @, dzetsaka [6 geoalgorithms]
::::z*ﬁ:z%':;i’““m' & 4 GDAL/OGR [48 geoalgorithms]
= -4 @y GRASS GIS 7 commands [314 geoal...
& & Models [0 geoalgorithms]
& @ Original & 3 Orfeo Toolbox (Image analysis) [119...
DR 88 Processing - 7 QGIS geoalgorithms (117 geoalgorit.
o |4 = @ 7 QGIS geoalgorithms [117 geoalgorit...
v, &- @ Scripts [0 geoalgorithms]
e [Eyers Panet B x

Virle@wva-320
[ [ — Faults_Hawaii

[t Geology_Hawaii

B Coherence Hawaii

0
0.858366

You can add more algorithms to the toolbox,
Coordinate|  -155.5730,19.5257 ¥ scale[1:298731 =] @ Magnifier[100% =] Rotation [0.0 =] ¥ Render @ EPSG:4326 @

Deactivate all layers and add the Displacement_Hawaii.tif from the Processing folder. Right-click on
it and go to Properties.

In the Transparency tab, set the “Additional no data value” to 0 to remove the black area of the layer.

In the Style tab go to Style = Load Style, navigate to the Auxdata folder and open the predefined
color palette: Displacement_qgis.qml.

Click OK.
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General ¥ Band rendering

Render type |singleband gray 'I

I.‘ Transparency Band |E|and 1 (Gray)

& Pyramids Min -0.347981 Max IO.ZBSBS

» Load min/ values

Layer Properties - Displacement_Hawaii | Style ﬂ
L=
=

Interpolation [Linear =1
@ veradata Color B dspectral = Edit I Invert
nd Label unit T

suffix

Min / max . .

origin: Estimated min / max of full extent.

Value Icalur Label
-0.348 14
-0.19 9
-0.0321 ) 21
0.284 a4 -

-

Style I I Cancel | Apply | Help |

Activate the Faults_Hawaii.shp, right-click on it, go to Properties and in the Style tab set the Color to
green and the Width to 0.46. Select OK.

Single symbol

Layer Properties - Faults_Hawaii | Style @
|

— Simple line

Millimeter
parency 0% _|

idth Io 6000 =
Symbols in group | x| open I.ib(aryl_

mnenen i (3] (B cceoeeeen —_— — =

@ wetadata

Variables

w Layer rendering
Layer transparency [t | = |
Layer blending mode [wormal =]
Feature blending mode [Normal =]

I~ Draw effects

Legend

™ Control feature rendering order

Style 'I I OK I Cancel Apply I Help I

el

,:/ QGIS 2.18.23 - Hawaii o
Project Edit View Layer Settings Plugins Vector Raster Database Web dzetsaka Processing Help

ICEBBLRIOR S 5 HPD L H N e e

8- LEET s . 7B

> /2 Ao = 5 [ [ o= o® = el s e
4./ B A RLENEEE R E Y
V=' [Browser Panel & x Processing Toolbox & x
o |Q@Y®0 -
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- @ 4 Models [0 geoalgorithms]
g ‘:;g’::s'i - 8 3 Orfeo Toolbox (Image analysis) [119...
9% i ng ;IJ @ 7 QGIS geoalgorithms [117 geoalgorit.
S| & @ Scripts [0 geoalgorithms]
%2} Layers Panel & x

LTl & %Y

@ . Geol
& (] @ Coher
0
0.858366
B Displacement_Hawaii
-0.348
-0.19
-0.0321

0.126
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You can add more algorithms to the toolbox.
Coordinate[  -154.7180,19.2051 % scale[1:298.731 ] @ Magnifier[100% =] Rotation [0.0 =] ¥ Render ) EPSG:4326
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7 Extra Steps

Google Earth is not pre-installed in RUS VMs and if you want to visualise the results, you need to
download them to your local computer. Let’s export the results to KML format. Go to SNAP and export
the bands you want from the final products (e.g. Phase, Coherence) as mentioned in the 5.7 chapter.
Go to File = Export = Other = View as Google Earth KMZ. Also, download from the Auxdata folder
the Fault_Google_Earth.kml file and then load them in Google Earth.

= Google Earth Pro - 08 X
Eile Edit View JTools Add Help

¥ Search [ 7 |

(phase)

Get Directions Mistory 214
¥ Places
v 8. My Places
» |/ Sightsecing Tour

¥ Study Area
» ¢ Phase ifg VV 23Apr2018 0

B Temporary Places

[ * |i] + ¢+

¥ Layers
v ® 2 Primary Database
& Ancouncements
» 8 P Borders and Labels
B Places
» L1 8 Photos
E= Roads
» I 30 Buildings
» & Ocean
¥ Westher
» W Gallery
» @ Globsl Awareness
» 0 More
Terain

Google Earth

< Google Earth Pro

Ele Edt View Tooks Add Help
v Search 7 |

(coherence)

Get Directions  Mistory 0.2
¥ Places
v 8 My Places
» |G Sightseeing Tour

¥ Sudy Area

» ¢ Faults_Google Earth.kml

B Temporary Places

Study Area

[ & ] + v 2

¥ Lavers
v 8 5 Primary Database
» 4@ Announcements
» ® P Borders and Labels
B Places
» ¥ Photos
ER Roads
» £ 30 Buildings
» /& Ocean
» L Weather
» # Gallery
» @ Global Awareness
» 0 More

Terrain

Google Earth

7.1  Download files from VM

In your VM, press Ctrl+Alt+Shift.

A pop-up window will appear on the left side of the screen. Click on the bar below Devices, navigate
to the folders you have saved the files you want to download and double click on them. The
downloading process to your local computer will start automatically.
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Once the KML files have been downloaded, you can load and visualize them in Google Earth.

front_vnc & user_usr-3304 ~

Clipboard

Text copied/cut within Guacamole will appear here. Changes to
the text below will affect the remote clipboard.

Devices

M /home/rus

Input method
* None

No input method is used. Keyboard input is accepted from a
connected, physical keyboard.

Text input

Allow typing of text, and emulate
keyboard events based on the typed
Sout Thi L i L x

THANK YOU FOR FOLLOWING THE EXERCISE!

8 Further reading and resources

e Richards J.A., 2009. Remote Sensing with Imaging Radar. Springer-Verlag Berlin Heidelberg. 376pp.

e Walter T.R., Amelung F., 2006. Volcano-earthquake interaction at Mauna Loa volcano, Hawaii.
Journal of Geophysical Research, vol. 111, B05204, 2006.

e Ghiglia D.C., Pritt M.D., 1998. Two-dimensional phase unwrapping: theory, algorithms, and
software. New York: Wiley. 493pp.

e http://www.esa.int/About Us/ESA Publications/InSAR Principles Guidelines for SAR Interfero
metry Processing and Interpretation br ESA TM-19 - InSAR Principles

e https://sentinel.esa.int/web/sentinel/missions/sentinel-1 - Sentinel-1 Mission

e https://earthquake.usgs.gov/hazards/ - Download Hawaii shapefiles
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RUS-Copernicus Training website
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http://www.esa.int/About_Us/ESA_Publications/InSAR_Principles_Guidelines_for_SAR_Interferometry_Processing_and_Interpretation_br_ESA_TM-19
http://www.esa.int/About_Us/ESA_Publications/InSAR_Principles_Guidelines_for_SAR_Interferometry_Processing_and_Interpretation_br_ESA_TM-19
https://sentinel.esa.int/web/sentinel/missions/sentinel-1
https://earthquake.usgs.gov/hazards/
https://twitter.com/RUS_Copernicus/
https://www.linkedin.com/groups/8623170
https://www.youtube.com/channel/UCB01WjameYMvL7-XfI8vRIA
https://www.facebook.com/RUSCopernicusService/
https://rus-copernicus.eu/portal/
https://rus-training.eu/
https://rus-copernicus.eu/portal/
https://rus-copernicus.eu/portal/
https://rus-training.eu/
https://www.facebook.com/RUSCopernicusService/
https://www.facebook.com/RUSCopernicusService/
https://twitter.com/RUS_Copernicus
https://www.linkedin.com/groups/8623170
https://www.youtube.com/channel/UCB01WjameYMvL7-XfI8vRIA

